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Navigation in the UI - Grids 

Navigation in the UI - Grids 
This chapter provides an overview of the FAB application features and main menus beginning 
with how to access the tool. 

Requesting Access 
 
[Prior to full implementation users will be granted access based on roles approved by Entity 
Budget and Planning offices.  After the full implementation the approval process will be formalized 
using a request for access form that will be routed to the Entity Budget and Planning offices for 
approval.] 
 

Logging in 
 
To access the FAB Planning Tools simply go to the following urls below.  Some users may be 
connected directly based on their CIT login (the login name and password for your personal 
workstation).  Others may be prompted to enter their workstation login names and passwords.  
This will depend on the policies that different IT support groups have defined for browser settings 
on workstations.  If integrated login is deployed as a policy, the login prompt will not be shown. 
 
In the training sessions we will complete group exercises together on the Training Site and you 
will complete follow-up exercises relevant to your division/program/department on the Production 
Site the week after training.  
 
Training Site: https://fagranby.fanda.ucar.edu/fabtrain/fab.aspx 
 
Production Site: https://fatahoe.fanda.ucar.edu/fab/fab.aspx#/Home 
 
Sample Login Windows: 
 

 
 

 
NOTE:  Some locations may require “CIT\user name”, others may require only the user name 

https://fagranby.fanda.ucar.edu/fabtrain/fab.aspx�
https://fatahoe.fanda.ucar.edu/fab/fab.aspx#/Home�
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Overview of Forecasting and Budgeting tool Features and Components 
Depending on how the application has been configured to meet you and your team’s needs, various grids 
and features will be available.   
 

General Features: 
No matter what the configuration, all users will have the following features: 
 

• Application Menu: Ability to switch between application configurations you have access to 
and define a default if you have more than one. 

• Non Salary Planning Menu: Plan non-salary expenses and subaward exclusions 
• Salary Planning Menu: Plan Account Key assignments, Adjust Work Time or CSC 

assumptions, Plan reclassifications, promotions, salary increases 
• Reports Menu: where different views of the created budgets can be accessed for assessment 

/ analysis. 
• Tools Menu: Option to add placeholder account keys and employees; and user defined 

attributes to accounts 
• Windows Menu (Arrange Windows) 
• Access to online Help 
• Grid Dimension Filter Selectors: where planning data sets are defined based on users needs 

or purview. 
• Grid View Menu: where various grid view options can be accessed 
• Refresh button: refreshes data in a grid 
• Grid Filter Row: option to filter a pre-defined data set even further by grid column 
• Grid Advanced Filter Editor: extension of filter row that provides additional options to filter a 

pre-defined data set even further by grid column 
• Add Attribute Columns to grids: option to add attributes of account keys and employees can 

be added to a grid view 
• Grid Column Sort: option to sort selected data in grids by column 
• Grid Column Group-by: option to group grid rows by a column in the grid 
• Grid Column Chooser: option to hide or unhide columns 

 

Restricted Features: 
The following features may be limited to designated division/program/lab and/or entity Budget and 
Planning office users: 

• Placeholder Employees: Option to add placeholder employees. 
• User-defined Attributes for Account Dimension: Option to define attributes of account keys for 

grouping keys to support planning and reporting. 
• Management of Financial Organization Hierarchy:  Option to change or enhance the account 

key hierarchy dimension. 
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Menu Bar Overview 
The FAB Menu bar contains the following menu items.  The 3 planning grid menus are dynamically 
created and may vary depending on your application configuration: 

• Application Menu 
• Planning grid menus: 

o Non Salary Planning Menu (Data Entry) 
o Salary Planning Menu (Data Entry) 
o Reports Menu 

• Tools Menu 
• Windows Menu 
• Help Menu 

  

 

Application Menu 
An application consists of specific girds configured to accommodate specific user group needs based on 
the type of budgeting and planning of their group. For example users who only budget on Indirect Keys 
have a simplified version of the planning grids; users who budget by Hours have different grids than those 
who budget by % in Key. These alternate configurations are defined as applications.  If a user has more 
than one application they may toggle between them using the Application menu.  This menu also 
provides the ability to: 

• Set Current Application as Default:   If you have more than one application you can define 
which one presents itself upon login. 

• Save Application Layout:  Save the window layout so it is the same very time you log in (See 
Windows Menu). 

• Restore Application Layout:  Restores grid layout to last saved configuration. (See Windows 
Menu). 
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Non Salary Planning Menu 
This menu lists the Non Salary Planning (Data Entry) grids that are available in the application and allows 
you to select one to display / activate.  

 
 

Salary Planning Menu 
This menu lists the Salary Planning (Data Entry) grids that are available in the application and allows you 
to select one to display / activate. 

 
 

Reports Menu 
This menu lists the Reports grids that are available in the application and allows you to select one to 
display / activate. 
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Tools Menu 
This menu provides access to the following features: 

• Account Key Placeholders: Create and edit placeholder accounts. 
• Employee Placeholders*: Create and edit placeholder employees  
• User-defined Account Attributes*: Create and edit your own account key attributes 
• Account Hierarchies*:  Manage Financial Org Structure 

   *Some restrictions apply. 
 

 

Windows Menu 
The Windows Menu provides options for arranging data entry and reporting grids. When first logging into 
the tool, the available windows in your application will be in cascade format as shown below.  Windows 
may be Tiled Vertical, Horizontal, and Minimized (Arrange Icons.  Infrequently used windows may also be 
closed but can be easily re-opened using the Non Salary Planning, Salary Planning, and Reports menus.  

 

 
 
 
NOTE 

Use the Windows Menu to arrange windows as desired and to quickly locate the grid set 
needed for the planning task at hand. 
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Group Step-by-Step  
 
 
 

Arrange and practice navigating different grids/windows. 
 
 
 

1. CLOSE GRIDS - Keep only the grids open you are working on or those you will most 
frequently use, which are typically: 

- Employee Account Allocation Data Entry Grid 
- Employee Projections Annual Report Grid 

2. Close other grids by pressing “x” in the upper right hand corner.  

 
3. Repeat step 2, closing all grids except: 

Employee Account Allocation Grid, %  

Employee Projections Annual Report 

 

4. TILE HORIZONTAL - Arrange those remaining two windows as follows by clicking on Window 
and selecting Tile Horizontal: 
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5. SAVE THE GRID VIEW - To Save this view when you log in next time, Go to the Application 
menu and click “Save Application Layout”: 

 
 

6. Close the browser and reopen.  Note your application appears as you last left it after saving 
the layout. 

NOTE: “Restore Application Layout” Returns the layout to the last saved version. 

Help Menu Bar 
To access the Online Help simply go to the Help menu and select View Help. 
 

 
 
Overview of Planning Grids  
(More detail is provided in specific modules.) 

Salary Planning Menu for Data Entry Grids 
• Plan Employee Assumptions  

o Adjust an employees work time or CSC assignment for planning purposes 
• Plan Employee Salaries  

o View current and prior records; add next records to plan for reclass, promotions, etc. 
• Plan Employee Account Allocation % in Key  

o Plan employee expenses on specific account keys for specific date ranges by % in key 
• Plan Employee Account Allocation – Hours by Quarter  

o Plan employee expenses on specific account keys for specific date ranges by Hours in 
quarter by key 

• Plan Employee Account Allocation – Monthly  
o Plan employee expenses on specific account keys for specific date ranges by Hours in 

month by key 

Non-Salary Planning Menu for Data Entry Grids 
• Plan Subaward MTDC Exclusions  

o Plan MTDC exclusions typically in Purchased Services or Materials and Supplies 
(Equipment and PSC are excluded by Expense Class / Object Code) 

• Plan Non-Salary Expenses – Spreading 
o Spreads one entry evenly over all months in Monthly Grid  

• Plan Non-Salary Expenses – Monthly  
o Allows for data entry by month, by account, by expenses class 
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Reports Menu for Report Grids 
• Scenario Assumptions (Reference for all Monitoring & Planning) 

o Past, present and projected UCAR rates used in planning calculations 
• Division CSC Rates (Reference for all Monitoring & Planning) 

o Past, present and projected CSC rates used in planning calculations 
• Budget Forecast Analysis Report  (All Monitoring & Planning) 

o Combines IFAS actuals to date with future planning information “forecast” expenses and 
account balances 

• Employee Projections Annual Pilot Report (Use with % in Key Salary Planning) 
o Summarizes information based on data input in the Salary Planning Grids, provides 

means for verification that staff are fully covered and accounts and staff are not over 
allocated. 

• Employee Projections Quarterly – By Fiscal Year (Use with Hourly Salary Planning) 
o Summarizes information based on data input in the Salary Planning Grids, provides 

means for verification that staff are fully covered and accounts and staff are not over 
allocated.  

• Employee Plan vs. Forecast Hours – By Fiscal Year (Hourly Monitoring & Planning) 
o Compares Plan to Forecast, provides a means for determining changes, corrections to 

plan. 
• Upload Report (Currently NCAR – Export of  Indirect, CSC & NSF Target Uploads) 

o Once planning is complete, provides Isolation of New Funds by with fields necessary for 
IFAS budget uploads via Excel export. 

• Workable Hours (Use with Hourly Salary Planning) 
o Indicates by person, workable hours based on calendar, FTE, and begin and end dates. 

• Unallocated Employees (Use with all Salary Planning) 
o Indicates active employees who are not allocated to account keys 

• Active Keys with No Planned Expenses (Use with all Salary & Non-Salary Planning) 
o Indicates active keys with no expenses yet planned 

 
Group Step-by-Step  
 
 
 

Examine the Available Windows Necessary for Salary Planning 
 
 

1. Close all the grids or windows. 

2. Open the Plan Employee Salaries Grid 

3. Open the Plan Employee Assumptions Grid  

4. Open the Plan Employee Account Allocation % in Key Grid 

5. Open the Unallocated Employees Grid 

6. Open the Plan Non-Salary Expenses – Spreading Grid 

7. Open Active Keys with No Planned Expenses Grid 
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Navigation in the UI - Grid View, Sorting, Layout, Export 
Functions 

Each grid has a menu bar with features used to create planning data.  The menus handle layout 
and appearance of a grid as well as the grid export feature.  We will look at View, Options, Filter 
Row and Attributes.  (Data Entry items - Save, Refresh, Cancel, Add Row Copy, Add Row and 
Delete are covered in detail with each specific grid.) 

View Menu 
The View Menu contains the following options: 

 

Save Grid Layout / Reset to Default 
 
The following grid functions covered in this chapter provide the ability to modify the appearance of 
a grid to meet your specific planning needs.   

• Add Attribute Columns 
• Re-arrange Columns 
• Group-by Column 
• Column Chooser – Show/Hide Columns 

 
Once you use these features to achieve the desired results, the layout can be saved.  At any 
time, the layout can also be reset to the default view as defined by the application.  Simply select 
View and either option to achieve the desired results.   

 

Export / Print View 
Any grid can be exported to the following file types: 

• PDF 
• HTML 
• RTF 
• XLS 
• XLSX 
• CSV 
• Text 
• Image File 
• XPS 



2 
Navigation in the UI – Grid View, Layout, Export Functions 

 
Group Step-by-Step  
 
 

Export Budget Forecast Analysis grid 
 

 
1. Go to the Budget Forecast Analysis Grid. 

2. From the View menu select Export / Print View 

 
 

3. The following screen appears.  Expand the window to show the full grid. 

 
 

4. You can select  Export Document or  Export Document to Window.  Click on the arrow on the right-
hand side of the icon to choose the file type.  For this exercise, select Export Document and XLS file 
type. 
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5. Click OK. 

 
 

6. Click OK. 

 
 

7. Save to the desktop with meaningful name and format/modify in Excel as needed.  

 
 
 
 

Notice that this process is the equivalent of paste-values in Excel.  There are no 
formulas in this downloaded file. 
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Simple Column Sorting and Filtering 
Once you have Dimension filters set up and saved from Chapter 3, you can dynamically sort and filter 
your data selections.   
 
NOTE 

You cannot save these filters.  These filters are meant to be used dynamically when 
you need to toggle back and forth between data sets on your grid as you are planning.  
 

 
 
 
Sorting Ascending and Descending by a Specific Column - Within any grid the data in the grid can be 
sorted by any column. 
 
Sort Ascending - the arrow at the right is pointing up 

  
 
Sort Descending - the arrow at the right is pointing down 
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Filter by selecting specific names - Click on the filter at the top right of the Column Label - a dropdown 
list of all unique items allows you to select one or more to view. 
 

              

 

 

Filter Row (Filter by Column Feature) 
After applying a Dimension Filters from Chapter 3, it is possible to filter the data selections further and 
more dynamically based on a column and a starts-with function using the Filter Row feature. 
 
NOTE 

You cannot save these filters.  These filters are meant to be used dynamically when 
you need to toggle back and forth between data sets on your grid as you are planning. 
For more permanent filters, you should save your filter selection in the dimension 
selector.  However, these provide quick, easy filtering for groups of data where you need 
to see various subsets. 

 
 
 
Group Step-by-Step  
 

Filter row by Fund Source column in the Plan NonSal Expenses – Sep grid 
 

 
 

 

1. Go to the Plan NonSalary Expenses Monthly Data Entry Grid. 

2. Click on the Filter Row button. 
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3. Type an “53” in the Obejct Code column – now only rows with the Object Code starting with 
“53” are showing.  Notice also that the Grid Totals change. 

 
 
 
NOTE 

If you think you may be missing information, check the filter row to determine if any filters 
are on.  When you change dimensions, filters can remain on, but hidden until you turn on 
the filter row. 

 
 

 

4. Disabling, clearing, or changing filters.  

 
 

To revert back to the original selection, you can also right-click on the column header and 
select Clear Filter. 
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Add Attribute Columns 
Attributes on key dimensions in a grid can be added as a column.  For instance you can add Fund Source 
Code from the Account Dimension to sort your keys or you can Add Division Code from the Employee 
Dimension to sort staff you planned on your keys from other Divisions / programs.    
 
Group Step-by-Step  
 

Add the Fund Source attribute from the Account Key dimension to the Budget 
Forecast Analysis Grid 

 
 
 

 

1. In the Budget Forecast Analysis grid, click on Attributes. 

 

2. From Dimension Name Drop Down List Select “cd_Account” (this is the Account Key dimension)  

 

3. From Attribute Name Drop Down List, Select Attribute “Fund_Source_Code” 

 

4. Click on “Add Attribute”, the new attribute will now be listed under Attributes currently on this data grid. 

 

5. Notice the Fund_Source_Code attribute is now listed as currently available. Click on “Save and Close”. 

 

6. Expend the details of the 1st

 

 account key in your grid and view the new column in the grid.  

7. Under the View Menu, select Save Grid Layout to keep the new Attribute. 

 

Re-arrange Columns – NOTE: These Changes Can be Saved under View Menu 
Columns may be re-arranged in your grid view to customize the view to help you work most efficiently.  
Simply click and drag the column to where you would like it to be placed.  Use the View Menu select Save 
the Grid Layout to save changes. 
 
As you drag the column arrows indicate it will drop between the two columns.  (If it does not drop where 
you thought it should, check the arrow indicators.) 

 
 
 
Now the Account Status column is moved between “Account” and “Budget Type” 
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NOTE – when all the columns do not fit within the window and you are moving from one end of grid to the 
other, you may have to move it several times to get to the correct spot. 

Column Menu 
In addition to the Filter Row feature, there is an advanced column filtering option: 
 
Group Step-by-Step  
 

Review Column Menu 
 

 
 

 

1. In the Budget Forecast Analysis grid, go to any column and right-click on the column header to 
open the Column Menu. 

 
2. Note the alternate Sort features as well as clearing.. 

 

3. “Group By” and “Column Chooser” are described in the next exercises. 

 

4. Best Fit sets the column width based on the entries on that column and for all columns, use 
Best Fit (all columns)  

 

Column Group-by 
In each grid you may choose a column to group by rendering expandable subtotals for that column.  
Simply right-click on a column and select Group By This Column. Some reporting grids (Budget Forecast 
Analysis and Employee Projections) default to a group-by view.  Budget Forecast Analysis is grouped by 
Account Key to provide a subtotal by key and Employee Projections is grouped by Employee to provide a 
subtotal by person. 
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Group Step-by-Step  
 

Group by the Fund Source Column in the Budget Forecast Analysis Grid 
 

 
 
 

1. In the Budget Forecast Analysis grid, right-click on the Group By Panel and select Clear Grouping.  

 
 

2. Right click on the Fund Source Column for the column menu and select Group By This Column. 

 
 

3. Note the results.  
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Column Chooser – Show/hide columns 
On any grid you may remove/add columns with the Column Chooser. 
 
Group Step-by-Step  
 

Hide Salary Object Code from Plan Employee Salaries grid. 
 

 
 
1. Select Salary Planning; select the Plan Employee Salaries grid. 

 

 
 
 

2. Right click on any column header for the Column Menu. Select Show Column Chooser. 

 
 
 

3. Click and drag the Salary Object Code Column to the Column Chooser 
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4. Close Column Chooser. 

 
 

5. Save Grid Layout with the Salary Object Code Column hidden. 

 
 

6. To add the column back to the Grid, right click any column header to open the Column Menu.  Select 
Show Column Chooser and drag the Salary Object Code Column back to the Grid, inserting it where you 
want it to appear. 

 

 
 
 

If a column “disappears” from your gid, check the column chooser.  You can move 
the column back up to the grid in the same way we hid the Position Number 
Column. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Navigation - Dimension Filters 
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Navigation in the UI - Dimension Filter Selectors 
Each grid contains a Dimension Selector that provides the ability to select and narrow down the 
planning data shown on the grid.  In this section we will set up dimension filter combinations you 
are most likely to use in real life planning exercises.  In these exercises we will make use of each 
of the methods of filtering data in the dimension selector (by Hierarchy, by Wildcard, by Attribute 
and by Subset). 
 

            
 

Saving Dimension Selections and Setting up your grids. 
In the hands-on exercises in this chapter, you will be able to save the dimension selections you 
create and name and save them for future. 
 
Typically, we are changing row selections to determine what we view in the grids. 

 

NOTE 
Named Dimension Selection Filters save a lot of time, but how you name the 
filters is critical to easily find the right information later on.  Some grids are 
associated with time or a fiscal year, others are continuous.  Some filtering allows 
you to see ANY UCAR employee planned on your keys, other filtering allows you 
to see ANY UCAR keys your employees are planned on. 
 
  
 

Dimension Filter Dropdown 
Hierarchy searches within UCAR, i.e., UCAR / NCAR / CISL / TDD or UCAR / UCP / COMET. 

Wildcard searches by numbers an account starts with, 40* returns JOSS account keys. 

Attribute searches by selected attribute, such as Division Code = 10 returns CGD. 

Subset provides special filtering; Level 0 selects ALL, i.e., employees or account keys in UCAR.  
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Plan Employee Salaries Grid - Create a Filter Using the Hierarchy 
 
Group Step-by-Step  
 
 
 

Create a Dimension Filter for Employees in your Division / Program for 
the Plan Employee Salaries Grid 

 
 
 

1. Go to the Plan Employee Salaries Data Entry Grid.

 

  (This grid is under the Salary Planning 
Tab.)   

2. Click on the dimension selector in the upper left hand corner of the grid.  

 
3. Click on the Employee dimension.   
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4. Within the Employee Dimension Selector, Select the Hierarchy Filter, open UCAR and 
applicable entity, lab or program to select your group.  Click Apply Filter in the lower 
left corner. NOTE:  Selected items appear in the Selected Members box on the right.   

HINT:  To open groups, click directly on the arrow – the arrow will change to blue.  To add a 
member to the selection box, click directly on the name. To clicking on any item replaces the 
previous; ctrl-click adds individual multiple items, shift-click adds sequential multiple items. 

 
 

5. Note how the employees listed in the grid have changed from Sample to your Division 
or Program. 

 

6. After data has loaded, click on the “Save As” button in the Dimension Filter Selectors 
panel and type in the name such as “CGD Emp Salaries” 

 

 
 

7. Note how the name of your new filter appears in the top drop-down list of the 
Dimension Selector panel.  
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8. Save the filter you have just created as your Default for this grid.   

 
 

9. Note how the default is indicated by a star symbol.  

 

 
 

10. Exit from the grid.   

 

11. Re-open the grid.  Observe that now your new default filter opens immediately to all 
employees with your group as their home division.
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Employee Assumptions Grid – Create a Filter using Hierarchy 
 

Group Step-by-Step  
 
 

Create a Dimension Filter for Employees in your Division / Program for the 
Employee Assumptions Grid 
 

1. Go to the Employee Assumption Grid.  (This Grid is under the Salary Planning Ta b.) 

2. Repeat steps 2–11 from the above exercise.  (For both the Salary Planning and Employee 
Assumptions Grids, these apply only to staff in your Division / Program, so the same Default 
Dimension applies in both cases.) 

 

Employee Account Allocation Grid – Create Filters using Wildcard and Subset 
Group Step-by-Step  
 
 

Create two Dimension Filters, one for just your Accounts (and ALL Employees 
planned to your accounts) and another for just your Employees and ALL Accounts 
to which they are planned.   

 
PART 1 
1. Go to the Employee Account Allocation Grid.  (Under the Salary Planning Tab.) NOTE – in this 

Exercise you will use the Accounts Dimension Selector and the Employee Dimension Selector. 

 

2. Open the Dimension Selector and Click on the Employee Dimension.  Within the Employee 
Dimension Selector, Select the Hierarchy Filter, open UCAR and applicable entity, lab or 
program to select your group.  Click Apply Filter. 
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3. Now that Employee has been selected for a Division or Program, Leave Account at “Level 0” 
to select ANY UCAR Account to which your employees may be allocated.  

 
 

4. After data has loaded, click on the “Save As” button in the Dimension Filter Selectors panel 
and type in the name.  

 
 

5. Note how the name of your new filter appears in the top drop-down list of the Dimension 
Selector panel.  

  
 
NOTE 

When using the Wildcard filter you can add more filters and use multiple filters with the 
implied “and”, such as 10* and 11*.) 

 

 
 

Wildcard selections cannot be made on dimensions that are in the Context area of the 
Dimension Filter Selector. 
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PART 2 

Remain on the Employee Account Allocation Grid.  We will now create the second filter, only 
our Accounts and Any Employee who may be planned to those accounts. 

NOTE 
“Level 0” selects ALL.  Remember, we want to change both the Employee and Account 
Dimensions, and we are selecting and changing the Dimension with “Level 0” first – so 
we don’t leave both at “Level 0” which selects ALL Account Keys and ALL Employees in 
UCAR.  
 

 

6. Open the Dimension Selector, Click on Account

 

 to Open the Account Dimension Selector, 
select Filter by the Hierarchy Filter, open UCAR and applicable entity, lab or program to select 
your group.  Click Apply Filter. 

 

7. Click on Employee

 

 to open the Employee Dimension Selector, select Filter by Subset, Click on 
the Subset Row and begin to type “le”, Level O should then appear to select ANY UCAR 
Employee.   Click Apply Filter. 

 

 

 

 



 

8 
Navigation in the UI - Dimension Filter Selectors 

8. After data has loaded, click on the “Save As” button in the Dimension Filter Selectors panel 
and type in the name.  

 
NOTE 

To rename a filter, select the filter, Save As, enter the new name, and then go back and 
delete the old filter. 

 

 
 

The Employee Account Allocations grid defaults to “Level 0” on all accounts. This means 
you see ALL accounts your employees are assigned to, within and outside your Division 
or Program.  If you filter Accounts by only your division or program on the account 
dimension, you may miss an assignment for your employees who are on other keys. 

 
 
 
Employee Projections Report Grid – Create Filters using Wildcard, Subset and 
Hierarchy  

Group Step-by-Step  
 
 

Create 2 Dimension Filters one for just your Accounts (and all Employees allocated 
to them) and another for just your Employees and ALL Accounts they may be 
planned on. 

 

1. Go to the Employee Projections Report. (This is under the Reports Tab.)  NOTE – in this Exercise 
you will use the Accounts Dimension Selector, the Employee Dimension Selector AND the 
PayPeriod_Expense (for FY) Dimension Selector. 

2. To create a filter for Div/Prog Employees on any Account, Repeat steps 2 – 3 from the above 
exercise AND add the the PayPeriod-Expense Dimension for Fiscal Year in Step 3 below

3. Click on PayPeriod_Expense to Open the Dimension Selector, select by Hierarchy, select 
“2013” for FY2013 to place it in the selected member box.  Click Apply Filter. 

. 
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4. After data has loaded, click on the “Save As” button in the Dimension Filter Selectors panel 
and type in the name. 

 
 

5. Remain on the Employee Projections Report Grid.  To create the second Filter for Div/Prog 
Accounts and ANY Employee, Repeat Steps 6 and 7 from the above exercise

 

.  NOTE:  The 
PayPeriod_Expense is already set at 2013 from the last filter you created. 
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6. After data has loaded, click on the “Save As” button in the Dimension Filter Selectors panel 
and type in the name. 

 
 

Budget Forecast Analysis Report Grid – Create Filter using Wildcard 

 
Group Step-by-Step  
 
 

Create a Dimension Filter for Division / Program Accounts for the Budget 
Forecast Analysis Report using Wildcard 

 
 
 
 
 

1. Go to the Budget Forecast Analysis Report.  (This Grid is under the Report Tab.) NOTE - in this 
exercise you will use the Accounts Dimension Selector and the YEAR Dimension Selector. 

For this Report we will create just one Filter for Division / Program Accounts  

 

2. Open the Dimension Filter, Select Account to open the Account Selector, Select the Filter by 
Wildcard, Type the first two digits of your Division or Program, followed by *, Click Apply 
Filter. 
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3. Click on Year to Open the Dimension Selector, select by Hierarchy, select “2013” for FY2013 
to place it in the selected member box.  Click Apply Filter. 
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4. After data has loaded, click on the “Save As” button in the Dimension Filter Selectors panel 
and type in the name. 
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Navigation in the UI - Placeholders 
 

Placeholder Employees and Placeholder Account Keys 
Placeholder employees and placeholder account key can be added to the planning model for 
anticipated new employees or anticipated new projects or funding.  Once added to the model, 
placeholder employees may be planned to keys like any other employee and staff time and non-
salary expenses may be planned to placeholder account keys.  (Not all users will have the ability 
to create placeholder employees or account keys).  
 
Placeholder Employees 
Placeholders are for anticipated new employees or to-be-determined existing employees. 
 
Group Step-by-Step  

 
Add a placeholder employee. 

 
 
 
 
 

1. Click on the Tools menu and select Employee Placeholders. 

 

1. Click on Add.  

 

 
You can only ADD Placeholders when all filters are off!  It may be easiest to 
only add new placeholders upon Opening the Tools Menu and selecting 
Employee Placeholder. 
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2. Complete all of the required fields in the placeholder employee form. 

 
 

NOTE 
 You may complete either the Annual Salary or the Hourly Rate field, the other will 
then system generate.  Be sure to enter your Home Division or Program for 
the  HR Org.  This places the placeholder in your group! 

 

 

3. Click on the Save button.   

Sample – Completed and Saved 

 
 
NOTE 

Status Code descriptions: 
EM     Active Employee (Default) 
TM    Terminated Employee 
NS    V2, V3 Visitor 
 
 Appointment Code (used to determine benefit rate) descriptions: 
C    Casual employee 
R1    Regular F/T 
R2    Regular P/T 
T1    Term F/T 
T2    Term P/T 
T3    Term (<6 months) F/T 
T4    Term (<6 months) P/T 
T5    Post Doc 
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4. Go to your Plan Employee Salary Grid – and be sure your Home Division / Program Filter you 
created earlier is selected.  Note the Current Record for the placeholder employee you created 
for your group appears in your list. 

 

Group Step-by-Step  
 

Edit a placeholder employee. 

 

  

1. Click on the Tools menu and select Employee Placeholders. 

 
 

2. Scroll through the grid at the bottom to find the employee you just created to edit.  You can 
sort by HR Org by clicking in the Label.   

 

 

You can also filter using the Filter Indicator,  to select your group and see only 
those placeholders to scroll through. 
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3. Select the Employee by clicking on the row and Click “Edit” in the Upper Left hand corner. 

 
 

 

4. Go to the Position Code field and type in the first few letters of the position you want to 
change this employee to and click on the Save button. Note how the new position now 
appears for that employee.  Save the name as well. 
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Placeholder Account Key 
Placeholder account keys are for anticipated new projects or funding.   
 
Group Step-by-Step  
 

Add a placeholder Account. 
 
 
 
 

1. Click on the Tools menu item, select Account Key Placeholders. 

 

2. Click on Add to create a new placeholder account key. 

 
 

3. Complete all of the required fields in the placeholder account form and click on the Save 
button. 
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4. Editing Placeholder Account Keys is identical to editing Placeholder Employees. 

 

 
NOTE 

Your Placeholder Account, within you Home Division / Program, will be available 
in the drop-down lists in the grids where you assign employees to account keys 
and where you create non-salary entries for your budget..  
NOTE- Use your Home Division / Program for the Financial Org.  You are only able 
to plan to keys in your Home Division / Program, including placeholder accounts. 

 

 
NOTE 

Account Rate Type field 
The following Rate Types exist in the model in order to determine which overhead rate to 
use in the Scenario Assumptions based on a given year. 
 
UCARGA:  UCAR G&A Overhead rate 
NCARON: NCAR On-site Overhead rate 
UCPON: UCP on-site overhead rate 
UCPOFF: UCP off-site overhead rate 
 
Financial Org field 
The Financial Org field is used to determine where your placeholder account key will roll-
up when selecting a group of account keys in a data entry grid or report 

 
 
 

  

 

https://test7.fabr.cms.ucar.edu/docs/scenario-assumptions�
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Planning - Plan Employee Salaries 
 

Plan Employee Salaries Grid – sourced from iVantage 

This grid is based on iVantage information.  Not all UI users will have access to this grid.  The 
grid includes only staff currently assigned to your Division / Program or Lab.  For these staff 
members, it includes current information as the “current” record, historical information as “prior” 
records and allows the planner to add planned changes as “Next” records. 
 

 

Key fields in Plan Employee Salaries grid: 
 
Employee Record:   Current and Prior records originate from iVantage for existing 

employees based on an annual Fiscal Year priming of the Working 
Plan scenario from the Incurred Actual scenario. For Placeholder 
Employees the Current record is created when the placeholder is 
created.  Next records are used to plan reclassifications or changes to 
FTE. 

Pos #:  Typically this is “1” except for a few employees who have two or more 
distinctly different, simultaneous appointments in iVantage, job titles 
and associated salaries. 

FTE: Drives planned hours worked calculations, this may be modified on a 
next record with or without a planned reclassification.  It may also be 
modified on a next record for Casuals who come in from iVantage on 
their current record defaulted to 1 FTE. 

Position code: Auto-fill field sourced from iVantage nightly, containing all 
available/exiting positions in the institution.  May be modified on a 
next record for a planned reclassification. 

Position Start Date: Reflects start date of last salary increase or position change on the 
current record (sourced from iVantage for current employees) and 
planned begin date of change to FTE or position on the next record.    

Position End Date: Reflects end date of the current record (sourced from iVantage for 
current employees).  When a next record is added, the end date on 
the current record should be changed to the day before the planned 
FTE or position change.    

Salary Adjustment %: Allows for an override to the scenario assumption for salary increase 
by employee. 

Salary Adjustment Date: Required if the Salary Adjustment % is filled so the system can know 
when the salary increase should be reflected in the planning numbers.   
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The information created in this grid does NOT go back to iVantage.   

 

 

Plan Reclassifications 
 
Group Step-by-Step  
 

Plan a reclassification for an employee. NOTE: this is for budget 
planning purposes only; it does not replace any portion of the 
Reclassification process. 

 
 
 
 
You can add a row for an employee by either selecting the row and Click “Add Row Copy” 
or you can select the employee, right click on the row and select “Add Row Copy” from 
the Drop Down Box. 
 
 

1. Select the employee you would like to add a reclassification for and click on the Add 
Row Copy button. 

 
 

You may also right-click on that row for the Drop Down Menu. 

 
 

2. Note that a copy of the current row appears as Next1. 
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Note as you place the cursor on either row,  the warnings on the Current Record “Error, 
overlapping dates on the following row(s): 2,3” and for the Next Record, “Date ranges are 
not contiguous for row: 3.” 

 

3. Change the end date of the current record to reflect the planned last day of the 
employee’s current position.  Change next record to reflect the planned start day and 
any changed in the end date.  

 
 

4. Change the anticipated salary level. 

 

5. Enter the new position code by clicking on the Position Code field and typing the first 
few letters of the position you want to assign to the employee. 

 

 
 

NOTE 
Important information for entering and Saving Data. - When cells are changed an 

 appears in the grid cell to indicate the information has not yet been saved.  To 
be certain changes are in, always tab off the cell you have entered in and observe 
the . 
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6. Notice the  on all the items you changed but have not yet saved.  Click Save. 

 

Plan Changes to FTE 
Independent Step-by-Step  

 

Plan a change to FTE.  NOTE: this is for budget planning purposes only; it does not 
replace the Profile FTE change process. 

 

 

Repeat steps 1-5 above and only change the employee’s FTE – not their position. 

Override Scenario Assumption for Planned Salary Increases 

There are 2 ways to plan for a salary increase: 

1. Scenario assumption for Salary Increases:  A corporate-wide setting that is defaulted to the 
value agreed to with NSF and the UCAR Board of Trustees. 

This is maintained by the UCAR Budget Management user group and can be found in the Report 
tab.  See Scenario Assumptions.  These are automatically applied to all employees unless overridden 
in the Plan Employee Salaries grid.  For broad planning purposes, this is typically sufficient.   

1. Planning for specific salary adjustment amounts and salary adjustment effective days can be 
done in fields in the Plan Employee Salaries grid. 

This can be used to override the scenario assumption for salary changes by an individual employee 
or group of employees.  Simply enter the change percent in the Salary Adjustment field, enter and 
effective date, copy those columns down for your list of employees if you want to make the same 
change to everyone, and click on the Save button 

 



 

 

 



 
Planning - Assumptions and 

Calculations 
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Planning - Assumptions and Calculations 
 
Key business drivers in the applications include Overhead Rates, Benefit Rates, Work time, CSC 
Assignments and planned Salary increases. These assumptions are applied to the data entry values 
created in Salary and Non Salary planning grids.  The resulting calculations are only visible in the 
Employee Projection and the consolidated Non-Salary Planning grids. 

Scenario Assumptions Report Grid 
This reporting grid holds the UCAR agreed upon assumptions for:  
 

• Overhead rates  - CANNOT be overridden by planners 
• Benefit rates – CANNOT be overridden by planners 
• Work time % - Global – CAN be overridden by Employee in Employee Assumptions Grid 
• Salary Increase % - Global – CAN be overridden by Employee in the Plan Employee Salary Grid 

 

 

Division CSC Rates Report Grid 
This reporting grid holds the UCAR agreed upon assumptions for Division CSC Rates. 
 

• CSC rates  - CANNOT be overridden by planners 
• CSC Assignments – CAN be reassigned for planning purposes by Employee in Employee 

Assumptions Grid 
 

 
 
 
 
NOTE 
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Since scenario assumptions impact all users and all data in the planning model scenarios, 
only a small set of users has the authority to change scenario assumptions. 
 

 
 
Employee Assumptions – Override Scenario Assumptions for Work time % 

The Employee Assumptions data entry grid holds user-defined assumptions for Work time % - by person. 
 
Group Step-by-Step  
 

Customize a single employee’s Work time %. 
 
 
 

 

1. From the Salary Planning menu, select the Employee Assumptions grid. 

  

 
 

2. Verify you have the saved, named default filter created earlier for your home Division / 
Program as the dimension selector.   

 

3. Click on Filter Row. 

 
 

4. To change work time %, choose an employee that has a position end date in the distant future 
and who has an FTE of 1 (refer to the Plan Employee Salaries grid). Enter the following values 
in the Work time Pct fields:  100%, 10/1/2012, 5/31/2013 

NOTE – A date range, with start and end date, is required with any work time override. 
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5. Open the Employee Projections Annual Report and with Filter Row, look at the employee you 
just changed and the current Loaded Salary Amount.  Press “Refresh” and notice the amount 
change. 

 
 

 

Group Step-by-Step  
 

 Apply the same Work time % override for multiple employees. 
 
 
 
 

Repeat steps 1-4 above and copy the work time % override fields from one employee to 
multiple employees.   

NOTE- to copy a work time % to other rows, use Ctrl+C and Ctrl+V and allow the web 
application to access your clipboard. 

 
 

If you add multiple line items to reflect changes to an employee’s work time % over time, 
you do not need to change their CSC assignment.  You can choose Add Row instead of 
Add Row Copy; enter the employee’s name and their new work time %.  Add Row Copy 
and changing their work time % will yield the same result. 
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Employee Assumptions - Plan Employee CSC Charges 
 
The annual CSC rates are housed in the Division CSC Rates - Report grid: 

 
 
 
Employee CSC Assignments are in the Employee Assumptions Grid. This is based on the IFAS CSC 
Assignment Application.  

 
 
 
 
 



5 
Planning – Assumptions and Calculations 

Typically CSC Rate Changes would be limited to adding Placeholder Employees.  Actual changes 
for IFAS expense purposes are done in the IFAS CSC Assignment Application.  There could be a 
few rare instances where you change these for planning purposes. 
 
Group Step-by-Step  
 

Create a CSC assignment for a placeholder employee. 
 
 
 
 

1. From the Salary Planning menu, select the Employee Assumptions grid. 

 
 

2. Verify you have the saved, named default filter created earlier for your home Division / 
Program as the dimension selector.  

 

3. Right click on any row and select Add Row Copy. 

 
4. In the employee field in your new row, type the first few letters of a placeholder’s name that 

you created earlier.   

NOTE – you can only see employees or placeholders where their HOME Division / Program = 
the Dimension Filter. 

5. Verify the CSC division and edit the CSC Rate Start and End date fields as needed for your 
plan.  Click on save. 

The placeholder employee should now appear in your list. 

 

NOTE 
Note – For groups with CSC Rates, Placeholder Employees have no CSC rate applied 
until they are added to the Home Division Assumptions Grid with the CSC rate.  This 
annual cost can be roughly $9 - $12K for a full-time employee.  
 
You can also change begin and end dates on CSC divisions for any employee using the 
same method as above 
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Date Ranges and impacts on calculations 
The following date ranges drive calculations in reporting grids. 
 

Grid Date Range Impact 
Plan Employee Salaries – 
Data Entry 

Position Start and End date Your working plan will not have any 
planned salary expenses for an 
employee in the reporting grids prior 
to their Position Start Date and after 
the Position End date 

Employee Assumptions – 
Data Entry 

Work time % Start and End 
Date 
 

Your working plan will default the 
Scenario Assumptions Work time % 
for an employee for each Fiscal Year 
prior to the Work time% Start Date 
and after the Work time % End Date.  
In the reporting grids, planned salary 
expenses will reflect this. 

Employee Assumptions – 
Data Entry 

CSC Rate Start and End Date 
 

Your working plan will  not have any 
planned CSC charges in the reporting 
grids prior to the CSC Rate Start Date 
and after the CSC Rate End date 

Employee Account 
Allocation % - Data Entry 

Start Date and End Date Your working plan will  not have any 
planned salary expenses for an 
employee in the reporting grids prior 
to their earliest assignment Start Date 
and after their latest assignment End 
date 
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Planning - Plan Employee Assignments % in Key 
Method 

 
The Salary – Non Salary Planning - % in Key application uses the Employee Account Allocation 
% - Data Entry grid to plan employee expenses on specific account keys using a date range 
approach.  This chapter covers how to create multiple assignments for employees over time.  

Create Assignments and View Results in Report 
Group Step-by-Step  

 
Create an assignment on an account key for an employee. 

 
 
 

1. Close all windows except the Employee Account Allocation % - Data Entry and 
Employee Projections Annual – Report.   

2. Select Window and Tile Horizontal.   

   

3. Select the same Dimension Filter for each grid to get the set of employees for your 
Division or Program.  (Such as the one with Div/Program Employees on Any Key or the one 
with All Div/Program Keys with Any Employee). 

4. In this exercise we will add an assignment for one of the employees in your selection. 

- Find that employee and note their total hours and amounts in the Employee Projections 
Annual – Report grid.   

- Show the detail by expanding the + symbol for an employee. 
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5. In the Employee Allocation Grid use “Filter Row” to select only information for the selected 
employee. 

 
 

6. In the Employee Projections Report Grid - Right click on the Employee Label at the top of the 
Grid, click "Ungroup" to have access to the Filter Row.  Use “Filter Row” to view only report 
information for the selected employee in the Report. 

 

7. Click on the Employee Account Allocation % - Data Entry grid to activate it. Right click on any 
row for that employee and select Add Row Copy. 

 
 

8. In the Account field, type the first few characters of the account you are going to assign the 
employee to and select the key from the drop down.   

NOTE: The searched item appears at the bottom of the top of the drop-down list. 
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9. Budget Type  defaults to “New Funds” but Drop Down Options allow you to select the budget 
type you are planning to: 

NOTE:  Typically salaries are planned to new funds, but there are instances where you may be 
planning to other budget types.  Budget Type is most critical when the plan is being used for an 
upload and all “New Funds” are equivalent to the budget target that will be uploaded. 

 

 

10. Line # - If this is a new key for the employee, enter “1”.   The grid will not save until a line 
number is entered. 

NOTE: Line # represents the number of times an employee is assigned to a single key and budget-
type during the current or future time frame.  Another planned assignment on the same key and 
budget type, would be “2” to reflect the second assignment.  See how the employee is planned three 
separate times in the same key, twice with the same budget type requiring both Line #1 and Line #2. 

 

 
 

11. Change the Percent in Key, Start Date, and End Date columns as desired for the new entry. 

 
 

12. Once you have fully edited the columns in the copied entry to reflect the new assignment in 
the new key: 

- Tab from the last cell you enter in and notice all the ’s in the cells you have edited 

- Click “Save” to keep the changes. 
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13. To check whether the person is over or under allocated, view the results in the Employee 
Projections Report Grid.  

- Click on the Grid to Activate the Grid 

- Click “Refresh” to see the changes reflected. 

 
 

14. Notice the person may now be over allocated when you added the new assignment. 

 

 
 
 

If you share employees with other Labs or Programs that use the hourly data entry 
method, your employee may appear to be over-allocated in the Employee Projections 
Report grid even though the hourly assignment does not appear in your data entry grid. 
To resolve this, look at the account key in the reporting grid, and contact the 
administrator responsible for that key to negotiate for the employee’s time.   
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Planning– Plan Employee Assignments – Hourly  
 

Create Assignments and View Results in Report 
Group Step-by-Step  
 

Create an assignment on an account key for an employee based on 
hours in each quarter. 

 
 
 

1. Confirm you are in the FAB Hourly application. 

2. Close all windows except the Employee Account Allocation – Hours by Quarter - Data 
Entry, Employee Projections Quarterly – 2013 Report.   

3. Select Window and Tile Horizontal. 

 

4. Select the same Dimension Filter for each grid to get the set of employees you would 
like to work with.  (Such as the one with Div/Program Employees on Any Key or the one 
with All Div/Program Keys with Any Employee). 

5. In this exercise we will add an assignment for one of the employees in your selection.  

- Find that employee and note their total hours and amounts in the Employee Projections 
Quarterly – Report grid.   

- Show the detail by expanding the + symbol for the employee:  
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6. In the Employee Allocation Grid use “Filter Row” to select only information for the 
selected employee. 

 

 

7. In the Employee Projections 2013 Report Grid - Right click on the Employee Label at 
the top of the Grid, click "Ungroup" to have access to the Filter Row.  Use “Filter Row” 
to view only report information for the selected employee in the Report. 

8. Click on the Employee Account Allocation Grid to activate it. Right click on any row for 
that employee and select Add Copy Row. 

 

9. In the Account field, type the first few characters of the account you are going to 
assign the employee to and select the key from the drop down. 

NOTE: The searched item appears at the bottom of the top of the drop-down list. 
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10. Budget Type  defaults to “New Funds” but Drop Down Options allow you to select the 
budget type you are planning to: 

NOTE:  Typically salaries are planned to new funds, but there are instances where you may 
be planning to other budget types.  Budget Type is most critical when the plan is being used 
for an upload and all “New Funds” are equivalent to the budget target that will be uploaded. 

 

11. Once you have edited the copied entry to reflect the new hours planned per quarter in 
the new key: 

- Tab from the last cell you enter in and notice all the ’s in the cells you have edited,  

- Click “Save” to keep the changes 

 

12. To check whether the person is over or under allocated, view the results in the 
Employee Projections Report grid by clicking Refresh in that grid.  

REFRESH is required for this report grid to show changes in the Employee Account 
Allocations. 

 
 
NOTE – For Quarter or Monthly data entry, while you have the person selected via Filter Row in 
the Employee Allocation Grid, you can see their total planned hours per quarter and do a quick 
check there.   
 
 
Delete assignments No Longer Valid 
In the Employee Account Allocation Grid, click on the row and click the “Delete” option. 
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If you share employees with other Labs or Programs that use the % in Key data 
entry method, your employee may appear to be over-allocated in the Report 
grids even though the hourly assignment does not appear in your data entry grid.  
To resolve this, look at the account key in the reporting grid, and contact the 
administrator responsible for that key to negotiate for the employee’s time. 
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Planning - Plan Non-Salary – Spreading Across Months 
 
The system provides two options, Spreading Across Months and Monthly Detail, for planning non salary 
budgets into time dimensions by account key, expense class and budget type.  The Spreading Option 
takes an annual estimate and spreads it evenly across all months in the fiscal year. 

NOTE  

FY12 non-salary budgets from IFAS were copied to the Spreading Grid in 
Working Plan to provide users a reference point for data entry.  Users will edit 
this information to reflect plans for FY13.  You can change the totals in the 
Spreading Grid (recommended) to spread your planned FY13 expenses and as 
necessary, select specific accounts to tweak monthly entries. 

 
Create a Non-Salary Budget 
 
Group Step-by-Step  
 

Edit Planned Expenses in your non salary plan. 
 

 
1. Close all windows except the Plan NonSal Expenses – Annual Spreading Working Plan.  

Check that you are using the Dimension Filter you created earlier in this Grid for your home 
Division/Program.  The Columns marked in yellow are for Non-Salary Data Entry.  The shaded 
columns are “context” columns. 

 
 

2. (Recall the user can arrange the columns in an order most useful for their work.)  Move the Total 
Program Exp Inc OH column in front of the M&S column. 

 

3. Save your new Column Layout by selecting “View” in the upper left corner and then selecting 
“Save Grid Layout” 

 
 



2 
Planning – Plan Non-Salary – Spreading Across Months 

4. Using “Filter Row” select a particular Account Key for planning that includes at least Budget 
Types of Uncommitted Carryover, Committed Carryover and New Funds.  Verify that you see 
only lines for that account key.  

 
 

5. Go to the New Funds Row and edit the data.   

- Tab from the last cell you enter in and notice all the  ’s in the cells you have edited, 

- Click Save to keep the changes.  NOTICE the Subtotals updated. 

 

6. Go to the row with Uncommitted Carryover and put “0” in all the cells. Tab from last entry, 
notice the ’s in the cells you have edited, click Save to keep the changes.   

NOTICE when all the entries are “0” for Non-salary, there are no comments and there are no planned 
salary expenses, the line is no longer shown. 

 

7. To insert a new row, place the cursor where you want to add a row and click “Add Row Copy”.    

- Edit Budget Type to “Expected Funds” change all items to “0” 

- Set Travel at $50,000 

- Tab from last entry, notice the  ’s in the cells you have edited 

- Click Save to keep the changes.  NOTICE the Subtotals updated. 

 

8. In the Filter Row, remove key you selected to see all your account keys with the “primed” 
reference point data as well as those you’ve edited in this exercise. 
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Group Step-by-Step  

 
Add a placeholder account (or an account not listed) to your non-salary plan. 

 
 

 

1. Select another account key in the Filter Row. 

 

2. Right-click on any row for that key and click on “Add Row Copy” to add a row. 

- Type the first few characters of the placeholder key you created earlier and select the key from 
the Drop Down List 

- Select Line # “1” from the Drop Down List 

- Select a Budget Type “Expected Funds” from the Drop Down List 

- Type the first few characters of the placeholder key you created earlier and select the key.  Fill in 
the fields as follows: 

 
- Click “Save” 

 

3. Open the Budget Forecast Report Grid.   

- Right Click on “Account” and select “UNGROUP” to have access to the Filter Row 

- Click on  Filter Row to look that the Placeholder Key you just added 

- Click “Refresh” and note the change in the report 
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Planning - Plan Non-Salary – Monthly Detail 
 
The system provides two options, Spreading Across Months and Monthly Detail, for planning non salary 
budgets into time dimensions by account key, expense class and budget type.  The Monthly Detail Option 
allows the user to enter and edit monthly estimates at the level of account, expense class and budget 
type detail.  

NOTE  

FY12 non-salary budgets from IFAS were copied to the Spreading Grid in 
Working Plan to provide users a reference point for data entry.  Users will edit 
this information to reflect plans for FY13.  You can change the totals in the 
Spreading Grid (recommended) to spread your planned FY13 expenses and as 
necessary, select specific accounts to tweak monthly entries.   

 
Create / Edit a Non-Salary Budget 
 
Group Step-by-Step  
 

Edit Specific Monthly Expenses in your non salary plan. 
 

 
1. Close all windows except the Plan NonSal Expenses – Monthly.  Check that you are using the 

Dimension Filter you created earlier in this Grid for your home Division/Program.  All the 
Columns are marked in yellow for Non-Salary Data Entry.  There are no shaded columns are 
“context” in this grid like there are in the Spreading Grid. 

 
 

2. Using “Filter Row” select a particular Account Key to edit that includes Budget Types of at 
least Uncommitted Carryover, Committed Carryover, and New Funds.  Verify that you see only 
lines for that account key.  
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3. Select any row, place the overall total for that line in January and zero out the rest of the cells.   

NOTE - This is done assuming you had entered your planned expense amounts for FY13 via the 
Spreading Grid and were only updating specific accounts where you need/want the forecast to be 
highly accurate rather than “close enough”; where the payoff is equal to time spent updating at this 
detail. 

- Tab from the last cell you enter in and notice all the  ’s in the cells you have edited, 

- Click Save to keep the changes.  NOTICE the Subtotals updated. 

 

4. Go to another row and begin entering a different number each month for that expense class 
and budget type.  

- Notice the TOTAL for the row change as you change each entry 

- NOTE - You can use Ctrl-C and Ctrl-V to copy the same entry to multiple cells 

- Tab from last entry, notice the ’s in the cells you have edited 

- Click “Save” to keep the changes.  NOTICE all your changes replaced the entries; these did not 
create a new record. 

 

5. To insert a new row, place the cursor where you want to add a row and click “Add Row Copy”.    

- Edit Budget Type to “Expected Funds” change all items to “0” 

- Set Travel at $50,000 

- Tab from last entry, notice the  ’s in the cells you have edited 

- Click Save to keep the changes.  NOTICE the Subtotals updated. 

 

6. In the Filter Row, remove key you selected to see all your account keys with the “primed” 
reference point data and those that you edited in this exercise. 
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Group Step-by-Step  

 
Add a placeholder account (or an account not listed) to your non-salary plan. 

 
 

 

1. Select another account key in the Filter Row. 

 

2. Right-click on any row for that key and click on “Add Row Copy” to add a row. 

- Type the first few characters of the placeholder key you created earlier and select the key from 
the Drop Down List 

-  Select an Object Code from the Drop Down List 

- Enter Line #2 (So you do not replace entries from the earlier exercise.) 

- Select a Budget Type “Expected Funds” from the Drop Down List 

- Enter $100 for each month 

- Tab off the last cell entered 

- Click “Save” 

 

3. Open the Budget Forecast Report Grid.   

- Right Click on “Account” and select “UNGROUP” to have access to the Filter Row. 

- Click on  Filter Row to look that the Placeholder Key you just added 

- Click “Refresh” and note the change in the report 
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Planning – Plan Sub-award MTDC Exclusions 
This planning tool offers the ability to identify sub-awards by expense class that will be greater 
than $25K and therefore partially excluded from the planned MTDC measure. 
 

NOTE  

FY12 non-salary budgets from IFAS were copied to the Spreading Grid in 
Working Plan to provide users a reference point for data entry.  Users will edit 
this information to reflect plans for FY13.  You can change the totals in the 
Spreading Grid (recommended) to spread your planned FY13 expenses and as 
necessary, select specific accounts to tweak monthly entries.   

 

Create SubAward Exclusions 
Group Step-by-Step  
 

Create an MTDC sub-award exclusion. 
 
 

 
1. Close all windows except the Plan SubAward MTDC Exclusions - Data Entry and Plan 

NonSal Expenses – Annual Spreading Working Plan – Data Entry.  Select Windows and 
Tile Horizontal. 

2. Select the Dimension Filters for your home Division or Program that you created 
earlier on both Grids. 

 

3.  Use Filter Row on both grids to select just the placeholder account key you edited in 
the last exercises.  (The $75K PS amount is used here.)  



2 
Planning – Plan Sub-award MTDC Exclusions 

4. In the Plan SubAward MTDC Exclusions – Data Entry, enter the following for the Purchases 
services line.  Note there are 2 required fields: 

 

- In the # of Sub-Contracts, enter “2” 

- In the Total $ Amount, enter of $70,000 

- In the Comment add “CU $35K, ASU $35K” as a reminder of what these exclusions are. 

 
- Click “Save” to keep the changes.  Notice the changes in MTDC Calculation. Note $50,000 is the 

amount subject to OH, 2 subcontracts x the first $25K on each.  Of the $70,000 total for the 
subcontracts, $50,000 is then excluded from OH. 

 

5. Click the refresh button on the Plan NonSal Expenses – Annual Spreading Working Plan – 
Data Entry screen. Note the difference in the MTDC measure in both grids.  The MTDC is now 
reduced based on the entry in Plan Subaward MTDC Exclusions. 

 

NOTE  

To limit the amount of data shown, the Plan Sub-Award MTDC Exclusion Grid currently 
defaults to showing only items that have $ planned in the 5200 or 5300 expense since 
most exclusions occur in Purchased Services and a few in Materials and Supplies.  
(PSC and Equipment are already excluded by expenses class from the data entry 
grids). 


	1. Navigation - UI Getting Started
	Navigation in the UI - Grids
	Requesting Access
	Logging in
	Overview of Forecasting and Budgeting tool Features and Components
	General Features:
	Restricted Features:

	Menu Bar Overview
	Application Menu
	Non Salary Planning Menu
	Salary Planning Menu
	Reports Menu
	Tools Menu
	Windows Menu
	Help Menu Bar
	Salary Planning Menu for Data Entry Grids
	Non-Salary Planning Menu for Data Entry Grids
	Reports Menu for Report Grids


	2. Navigation - Grid View, Layout, Filter, Sort and Export_bgs
	Navigation in the UI - Grid View, Sorting, Layout, Export Functions
	View Menu
	Save Grid Layout / Reset to Default
	Export / Print View

	Simple Column Sorting and Filtering
	Filter Row (Filter by Column Feature)
	/
	Add Attribute Columns
	Re-arrange Columns – NOTE: These Changes Can be Saved under View Menu
	Column Menu
	Column Group-by
	Column Chooser – Show/hide columns


	3. Navigation - Dimension Filters_bgs
	Navigation in the UI - Dimension Filter Selectors
	Saving Dimension Selections and Setting up your grids.
	Plan Employee Salaries Grid - Create a Filter Using the Hierarchy
	Employee Assumptions Grid – Create a Filter using Hierarchy
	Employee Account Allocation Grid – Create Filters using Wildcard and Subset


	4. Navigation - Placeholder Employees and Account Keys
	Navigation in the UI - Placeholders
	Placeholder Employees and Placeholder Account Keys
	Placeholder Account Key


	5. Planning - Plan Employee Salaries
	Planning - Plan Employee Salaries
	Plan Employee Salaries Grid – sourced from iVantage
	This grid is based on iVantage information.  Not all UI users will have access to this grid.  The grid includes only staff currently assigned to your Division / Program or Lab.  For these staff members, it includes current information as the “current”...
	Key fields in Plan Employee Salaries grid:

	Plan Reclassifications
	Plan Changes to FTE
	Override Scenario Assumption for Planned Salary Increases


	6. Planning - Assumptions and Calculations
	Planning - Assumptions and Calculations
	Scenario Assumptions Report Grid
	Division CSC Rates Report Grid
	Employee Assumptions - Plan Employee CSC Charges
	Date Ranges and impacts on calculations


	7. Planning - Plan Employee Assignments % in Key Method
	Planning - Plan Employee Assignments % in Key Method
	Create Assignments and View Results in Report


	8. Planning - Plan Employee Assignments Hourly
	Planning– Plan Employee Assignments – Hourly
	Create Assignments and View Results in Report


	9. Planning - Plan Non-Salary Spreading
	Planning - Plan Non-Salary – Spreading Across Months

	10. Planning - Plan Non-Salary Monthly
	Planning - Plan Non-Salary – Monthly Detail

	11. Planning - Plan Sub-award MTDC Exclusions
	Planning – Plan Sub-award MTDC Exclusions
	Create SubAward Exclusions





